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C H A P T E R 13

Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454, including database backup and 
restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware 
maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance 
procedures.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide as necessary for general 
troubleshooting information and alarm or error descriptions. 

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G103 Back Up the Database, page 13-2—Complete as needed.

2. NTP-G104 Restore the Database, page 13-2—Complete as needed.

3. NTP-G105 Restore the Node to Factory Configuration, page 13-4—Complete as needed to clear the 
database and upload a blank database and the latest software.

4. NTP-G133 View and Manage OSI Information, page 13-10—Complete as needed.

5. NTP-G106 Reset Cards Using CTC, page 13-13—Complete as needed to reset the TCC2/TCC2P 
cards and the dense wavelength division multiplexing (DWDM) cards.

6. NTP-G108 Viewing the Audit Trail Records, page 13-15—Complete as needed.

7. NTP-G109 Off-Load the Audit Trail Record, page 13-17—Complete as needed.

8. NTP-G110 Off-Load the Diagnostics File, page 13-18—Complete as needed. 

9. NTP-G112 Change the Node Timing Reference, page 13-18—Complete as needed.

10. NTP-G113 View the ONS 15454 Timing Report, page 13-20—Complete as needed.

11. NTP-G114 Inspect and Replace the Air Filter, page 13-23—Complete as needed.

12. NTP-G115 Clean Fiber Connectors, page 13-26—Complete as needed.

13. NTP-G40 Replace the Front Door, page 13-29—Complete as needed.

14. NTP-G116 Replace the Fan-Tray Assembly, page 13-31—Complete as needed.

15. NTP-G117 Replace the ANSI Shelf Alarm Interface Panel, page 13-36—Complete as needed.
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16. NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover, page 13-40—Complete as 
needed.

17. NTP-G135 Edit Network Element Defaults, page 13-42—Complete as needed to edit the 
factory-configured (default) network element (NE) settings for the Cisco ONS 15454.

18. NTP-G136 Import Network Element Defaults, page 13-43—Complete as needed to import the 
factory-configured (default) NE settings for the Cisco ONS 15454.

19. NTP-G137 Export Network Element Defaults, page 13-44—Complete as needed to export the 
factory-configured (default) NE settings for the Cisco ONS 15454.

20. NTP-G166 View the Facilities, page 13-45—Complete as needed to view all facilities for the Cisco 
ONS 15454.

NTP-G103 Back Up the Database

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node you want to back up. If you are 
already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Database tabs.

Step 3 Click Backup.

Step 4 Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name 
with the DB file extension; for example, database.db.

Step 5 Click Save.

Step 6 Click OK in the confirmation dialog box.

Stop. You have completed this procedure.

NTP-G104 Restore the Database

Purpose This procedure stores a backup version of the TCC2/TCC2P (software) 
database on the workstation running Cisco Transport Controller (CTC) 
or on a network server.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required. Cisco recommends performing a database backup at 
approximately weekly intervals and prior to and after configuration 
changes.

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This procedure restores the TCC2/TCC2P card software database, either 
partially or completely.

Tools/Equipment None
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Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are restored only when the  Complete Database (System and Provisioning) 
checkbox is checked: node name, IP address, subnet mask and gateway, and IIOP port. If you change the 
node name and then restore a backed up database on this node, the circuits automatically  map to the 
newly renamed node. It is recommended to keep a record of the old and new node names.

Caution If you are restoring the database on multiple nodes, wait approximately one minute after the 
TCC2/TCC2P card reboot has completed on each node before proceeding to the next node.

Caution TCC2P cards can be used in single IP address (repeater) and dual IP address (secure) mode. The secure 
mode has advanced features that affect database restore. A database from a secure node cannot be loaded 
on an unsecure repeater node. A repeater mode database can be loaded onto a secure node but the 
database will follow the node characteristics (that is, it will become secure). A secure database cannot 
be loaded onto a TCC2; only TCC2P cards support secure mode. For more information about the dual 
IP secure mode, see the “NTP-G26 Set Up CTC Network Access” procedure on page 3-13. Also refer to 
the “Management Network Connectivity” chapter of the Cisco ONS 15454 DWDM Reference Manual. 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you are restoring the 
database. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab. Verify that 
no optical channel network connection (OCHNC) circuits have a PARTIAL_OOS state. If so, investigate 
and resolve the partial state before continuing.

Step 3 Complete the “DLP-G157 Disable Automatic Power Control” task on page 10-4.

Step 4 In multishelf view (multishelf mode) or in node view (single-shelf mode), click the Maintenance > 
Database tabs.

Step 5 Click Restore.

Step 6 Locate the database file stored on the workstation hard drive or on network storage. 

Note To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 
software CD.

Step 7 Click the database file to highlight it. 

Step 8 Click Open. The DB Restore dialog box appears. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Caution Opening a restore file from another node or from an earlier backup might affect traffic on the login node.

Step 9 If you need a complete database restore, check the Complete database (System and Provisioning) 
checkbox. Continue with Step 11.

Note Complete database restore may be used only on a node that is removed from the network, and does not 
carry live provisioning traffic. This operation needs to be done by a live operator onsite, and must not 
use a remote connection.

Step 10 If you need to restore only the provisioning database (partial restore), do not check the Complete 
database (System and Provisioning) checkbox.

Step 11 Click Ok.

The Restore Database dialog box monitors the file transfer (Figure 13-1).

Figure 13-1 Restoring the Database—In-Process Notification

Step 12 Wait for the file to complete the transfer to the TCC2/TCC2P card.

Step 13 Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for 
the node to reconnect.

Step 14 Complete the “DLP-G158 Enable Automatic Power Control” task on page 10-5.

Stop. You have completed this procedure.

NTP-G105 Restore the Node to Factory Configuration

Purpose This procedure reinitializes the ONS 15454 using the CTC 
reinitialization tool. Reinitialization uploads a new software package to 
the TCC2/TCC2P cards, clears the node database, and restores the 
factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 8.5

JRE 5.0 is recommended to log into the node after reinitialization is 
complete. The reinitialization tool can run on JRE 1.3.1_02, JRE 1.4.2, 
or JRE 5.0. 
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Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinitialization tool chooses the first product-specific software package in the specified directory if 
you use the Search Path field instead of the Package and Database fields. You might accidentally copy 
an incorrect database if multiple databases are kept in the specified directory.

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Cisco recommends that you save the node database to safe location if you will not be restoring the node 
using the database provided on the software CD.

Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Note A node will remain locked in secure mode even if it is restored with the factory database. A node locked 
in secure mode can only be unlocked by Cisco Technical Support.

Step 1 If you need to install or replace one or more TCC2/TCC2P cards, see the “DLP-G33 Install the TCC2 
or TCC2P Card” task on page 1-77.

Step 2 If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear 
the Database and Upload Software (Windows)” task on page 13-6.

Step 3 If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database 
and Upload Software (UNIX)” task on page 13-8.

Stop. You have completed this procedure.

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

NTP-G17 Set Up Computer for CTC, page 2-2

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser only
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DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload 
Software (Windows)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Note The ONS 14545 Software CD is if the Reinit.jar file, the CISCO 15454 package file, and the NE default 
file are not stored on your computer.

Note A node will remain locked in secure mode even if it is restored with the factory database. A node locked 
in secure mode can only be unlocked by Cisco Technical Support.

Step 1 Insert the ONS 15454 System Software CD, Version 8.5.x, into the computer CD-ROM drive. If the CTC 
Installation Wizard appears, click Cancel.

Step 2 From the Windows Start menu, choose Run. In the Run dialog box, click Browse and navigate to the 
CISCO15454 or CISCO15454SDH folder on the software CD.

Step 3 In the Browse dialog box Files of Type field, choose All Files. 

Step 4 Choose the RE-INIT.jar file and click Open. The NE Re-Initialization window appears (Figure 13-2).

Purpose This task reinitializes the ONS 15454 using the CTC reinitialization tool 
on a Windows computer. Reinitialization uploads a new software 
package to the TCC2/TCC2P cards, clears the node database, and 
restores the factory default parameters.

Tools/Equipment ONS 15454 System Software CD, Version 8.5

JRE 5.0 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02, JRE 1.4.2, or JRE 5.0. 

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

NTP-G17 Set Up Computer for CTC, page 2-2

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed to clear the existing database from a TCC2/TCC2P and 
restore the node default settings.

Onsite/Remote Onsite

Security Level Superuser only
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Figure 13-2 Reinitialization Tool

Step 5 Complete the following fields: 

• GNE IP—If the node you are reinitializing is accessed through another node configured as a 
gateway network element (GNE), enter the GNE IP address. If you have a direct connection to the 
node, leave this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version.

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than 
the installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tab.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 

• Search Path—Enter the path to the CISCO15454 folder on the CD drive.

Step 6 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 7 Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated, and the database is uploaded 
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. 
Wait a few minutes for the reboot to complete.

Step 8 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-26.
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Step 9 Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-10 
and the “NTP-G26 Set Up CTC Network Access” procedure on page 3-13.

Step 10 Return to your originating procedure (NTP).

DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload 
Software (UNIX)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Note A node will remain locked in secure mode even if it is restored with the factory database. A node locked 
in secure mode can only be unlocked by Cisco Technical Support.

Step 1 Insert the system software CD containing the reinitialization tool, software, and defaults database into 
the computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually 
/cdrom/cdrom0/CISCO15454 or /cdrom/cdrom0/CISCO15454SDH).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file. If you are working with a command 
line, run java -jar RE-INIT.jar. The NE Re-Initialization window appears (Figure 13-2).

Step 4 Complete the following fields: 

Purpose This task reinitializes the ONS 15454 using the CTC reinitialization tool 
on a UNIX computer. Reinitialization uploads a new software package 
to the TCC2/TCC2P cards, clears the node database, and restores the 
factory default parameters.

Tools/Equipment ONS 15454 SONET System Software CD, Version 8.5

JRE 5.0 must be installed on the computer to log into the node at the 
completion of the reinitialization. The reinitialization tool can run on 
JRE 1.3.1_02, JRE 1.4.2, or JRE 5.0.

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

NTP-G17 Set Up Computer for CTC, page 2-2

One of the following: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454, page 2-21

Required/As Needed As needed to clear the existing database from a TCC2/TCC2P and 
restore the node default settings.

Onsite/Remote Onsite

Security Level Superuser only
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• GNE IP—If the node you are reinitializing is accessed through another node configured as a GNE, 
enter the GNE IP address. If you have a direct connection to the node, leave this field blank.

• Node IP—Enter the node name or IP address of the node that you are reinitializing.

• User ID—Enter the user ID needed to access the node. 

• Password—Enter the password for the user ID.

• Upload Package—Check this box to send the software package file to the node. If unchecked, the 
software stored on the node is not modified.

• Force Upload—Check this box to send the software package file to the node even if the node is 
running the same software version. If unchecked, reinitialization will not send the software package 
if the node is already running the same version. 

• Activate/Revert—Check this box to activate the uploaded software (if the software is a later than the 
installed version) or revert to the uploaded software (if the software is earlier than the installed 
version) as soon as the software file is uploaded. If unchecked, the software is not activated or 
reverted after the upload, allowing you to initiate the functions later from the node view 
Maintenance > Software tab.

• Re-init Database—Check this box to send a new database to the node. (This is equivalent to the CTC 
database restore operation.) If unchecked, the node database is not modified. 

• Confirm—Check this box if you want a warning message displayed before any operation is 
performed. If unchecked, reinitialization does not display a warning message. 

• Search Path—Enter the path to the CISCO15454 or CISCO15454SDH folder on the CD drive.

Step 5 Click Go. 

Caution Before continuing with the next step, verify that the database to upload is correct. You cannot reverse 
the upload process after you click Yes.

Step 6 Review the information in the Confirm NE Re-Initialization dialog box, then click Yes to start the 
reinitialization. 

The reinitialization begins. After the software is downloaded and activated and the database is uploaded 
to the TCC2/TCC2P cards, “Complete” appears in the status bar and the TCC2/TCC2P cards will reboot. 
Wait a few minutes for the reboot to complete.

Step 7 After the reboot is complete, log into the node using the “DLP-G46 Log into CTC” task on page 2-26.

Step 8 Complete the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-10 
and the “NTP-G26 Set Up CTC Network Access” procedure on page 3-13.

Step 9 Return to your originating procedure (NTP).
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NTP-G133 View and Manage OSI Information

Note Additional information about the ONS 15454 implementation of OSI is provided in the “Management 
Network Connectivity” chapter in the Cisco ONS 15454 DWDM Reference Manual.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26. If you are already logged in, continue with 
Step 2.

Step 2 Perform any of the following tasks as needed:

• DLP-G298 View IS-IS Routing Information Base, page 13-10

• DLP-G299 View ES-IS Routing Information Base, page 13-11

• DLP-G300 Manage the TARP Data Cache, page 13-12

Stop. You have completed this procedure.

DLP-G298 View IS-IS Routing Information Base

Purpose This procedure allows you to view and manage Open Systems 
Interconnection (OSI) including the End System to Intermediate System 
(ES-IS) and Intermediate System to Intermediate System (IS-IS) routing 
information tables, the Target Identifier Address Resolution Protocol 
(TARP) data cache, and the manual area table.

Tools/Equipment None

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

NTP-G17 Set Up Computer for CTC, page 2-2

NTP-G132 Provision OSI, page 3-30

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task allows you to view the IS-IS protocol routing information base 
(RIB). IS-IS is an OSI routing protocol that floods the network with 
information about NEs on the network. Each NE uses the information to 
build a complete and consistent picture of a network topology. The IS-IS 
RIB shows the network view from the perspective of the IS node.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
IS-IS RIB tabs.

Step 2 View the following RIB information for Router 1:

• Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination 
address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.

• Location—Indicates the OSI subnetwork point of attachment. For data communications channel 
(DCC) subnets, the slot and port are displayed. LAN subnets are shown as LAN. 

• Destination Address—The destination Network Service Access Point (NSAP) of the IS.

• MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3 If additional routers are enabled, you can view their RIBs by choosing the router number in the Router 
field and clicking Refresh.

Step 4 Return to your originating procedure (NTP).

DLP-G299 View ES-IS Routing Information Base

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
ES-IS RIB tabs.

Step 2 View the following RIB information for Router 1:

• Subnet Type—Indicates the OSI subnetwork point of attachment type used to access the destination 
address. Subnet types include SDCC, LDCC, GCC, OSC, and LAN.

• Location—Indicates the subnet interface. For DCC subnets, the slot and port are displayed. LAN 
subnets are shown as LAN. 

• Destination Address—The destination IS NSAP.

• MAC Address—For destination NEs that are accessed by LAN subnets, the NE’s MAC address.

Step 3 If additional routers are enabled, you can view their RIBs by choosing the router number in the Router 
field and clicking Refresh.

Step 4 Return to your originating procedure (NTP).

Purpose This task allows you to view the ES-IS protocol RIB. ES-IS is an OSI 
protocol that defines how end systems (hosts) and intermediate systems 
(routers) learn about each other. For ESs, the ES-IS RIB shows the network 
view from the perspective of the ES node. For ISs, the ES-IS RIB shows the 
network view from the perspective of the IS node.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
13-11
Cisco ONS 15454 DWDM Procedure Guide, R8.5

78-18108-02



 

Chapter 13      Maintain the Node
DLP-  G300 Manage the TARP Data Cache
DLP-G300 Manage the TARP Data Cache

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > OSI > 
TDC tabs.

Step 2 View the following TDC information:

• TID—The target identifier of the originating NE. For ONS 15454s, the TID is the name entered in 
the Node Name/TID field on the Provisioning > General tab.

• NSAP/NET—The NSAP or Network Element Title (NET) of the originating NE. 

• Type—Indicates how the TDC entry was created:

– Dynamic—The entry was created through the TARP propagation process.

– Static—The entry was manually created and is a static entry.

Step 3 If you want to query the network for an NSAP that matches a TID, complete the following steps. 
Otherwise, continue with Step 4.

Note The TID to NSAP function is not available if the TDC is not enabled on the Provisioning > OSI > 
TARP subtab.

a. Click the TID to NSAP button. 

b. In the TID to NSAP dialog box, enter the TID you want to map to an NSAP. 

c. Click OK, then click OK in the information message box.

d. On the TDC tab, click Refresh.

If TARP finds the TID in its TDC, it returns the matching NSAP. If not, TARP sends protocol data 
units (PDUs) across the network. Replies will return to the TDC later, and a check TDC later 
message is displayed. 

Step 4 If you want to delete all the dynamically generated TDC entries, click the Flush Dynamic Entries 
button. If not, continue with Step 5.

Step 5 Return to your originating procedure (NTP).

Purpose This task allows you to view and manage the TARP data cache (TDC). The 
TDC facilitates TARP processing by storing a list of TID to NSAP 
mappings.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G106 Reset Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you are performing the 
TCC2/TCC2P reset. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 13-13.

Step 3 As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 13-14.

Stop. You have completed this procedure. 

DLP-G250 Reset the TCC2/TCC2P Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning 
change you made to avoid losing any changes to the database.

Note When a software reset is performed on an active TCC2/TCC2P, the AIC-I card goes through an 
initialization process and also resets. The AIC-I card reset is normal and happens each time an active 
TCC2/TCC2P card goes through a software-initiated reset.

Purpose This procedure resets the TCC2/TCC2P and DWDM cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-77

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task resets the TCC2/TCC2P card and switches the node to the 
redundant TCC2/TCC2P.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-77

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 9-29 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Step 2 In node view, right-click the TCC2/TCC2P card to reveal a shortcut menu.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click Close when the “Lost connection to node, changing to Network View” dialog box appears.

Step 6 Return to node view (single-shelf mode) or multishelf view (multishelf mode) and confirm that the 
TCC2/TCC2P card LED is amber (standby).

Step 7 Return to your originating procedure (NTP).

DLP-G251 Reset DWDM Cards Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note ONS 15454 cards normally do not need to be reset. However, you might occasionally need to reset a card 
for testing or as an initial trouble-clearing step. For additional information, refer to the Cisco ONS 15454 
DWDM Troubleshooting Guide.

Note A software reset of the TXP and MXP card leads to removal of PM data from the PM counters. As a 
result, the PM counters do not display any PM data.

Purpose This task resets the OSCM, OSC-CSM, 32MUX-O, 40-MUX-C, 
32DMX-O, 32DMX, 40-DMX-C, 40-DMX-CE, 32WSS, 40-WSS-C, 
40-WSS-CE, OPT-BST, OPT-PRE, OPT-AMP-17-C, 40-WXC-C, 
AD-xC.xx.x, AD-xB.xx.x, transponder (TXP), muxponder (MXP), and 
ADM-10G cards using CTC.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-53

NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-58

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 If you will switch an active TXP or MXP card that is in a Y-cable protection group, complete the 
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 10-41. If not, continue 
with Step 2.

Step 2 Right-click the card that you want to reset to reveal a shortcut menu.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white 
LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

Step 5 If you performed a Y-cable protection group switch in Step 1, complete the “DLP-G180 Clear a Manual 
or Force Y-Cable or Splitter Protection Switch” task on page 10-42. If not, continue with Step 6.

Step 6 Return to your originating procedure (NTP).

NTP-G108 Viewing the Audit Trail Records

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to view the audit 
trail log. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click, click the Maintenance > 
Audit tabs.

Step 3 Click Retrieve.

A window containing the most recent audit trail records appears as shown in Figure 13-3.

Purpose This procedure explains how to view audit trail records. Audit trail records 
are useful for maintaining security, recovering lost transactions, and 
enforcing accountability. Accountability refers to tracing user activities; 
that is, associating a process or action with a specific user.

Tools/Equipment None

Prerequisite 
Procedures

None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
13-15
Cisco ONS 15454 DWDM Procedure Guide, R8.5

78-18108-02



 

Chapter 13      Maintain the Node
DLP-  G251 Reset DWDM Cards Using CTC
Figure 13-3 Viewing the Audit Trail Records

A definition of each column in the audit trail log is listed in Table 13-1.

Left-click the column headings to display the list in ascending-to-descending or 
descending-to-ascending order. 

Right-click the column heading to display the following options:

• Reset Sorting—Resets the column to the default setting.

• Hide Column—Hides the column from view.

• Sort Column—Sorts the table by the column’s values.

• Sort Column (incremental)—Sorts the table incrementally by multiple columns.

• Reset Columns Order/Visibility—Displays all hidden columns.

• Row Count—Provides a numerical count of log entries.

Shift-click the column heading for an incremental sort of the list.

Stop. You have completed this procedure.

Table 13-1 Audit Trail Column Definitions

Column Definition

Date Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (that is, whether or not the action was executed)

Operation Action that was taken
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NTP-G109 Off-Load the Audit Trail Record

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to off-load the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click, click the Maintenance > 
Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save. Click OK.

The 640 entries are saved in this file. The next entries continue with the next number in the sequence, 
rather than starting over.

Note Archiving does not delete entries from the CTC audit trail log. However, entries can be 
self-deleted by the system after the log maximum is reached. If you archived the entries, you 
cannot reimport the log file back into CTC and will have to view the log in a different 
application.

Stop. You have completed this procedure.

Purpose This procedure describes how to off-load up to 640 audit trail log entries 
in a local or network drive file to maintain a record of actions performed 
for the node. If the audit trail log is not off-loaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G110 Off-Load the Diagnostics File

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to off-load the 
diagnostics file. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Diagnostic tabs.

Step 3 Click Retrieve Tech Support Log.

Step 4 In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be 
unzipped and read by Cisco Technical Support.

Step 6 Click Save.

The Get Diagnostics status window shows a progress bar indicating the percentage of the file being 
saved, then shows “Get Diagnostics Complete.”

Step 7 Click OK.

Stop. You have completed this procedure.

NTP-G112 Change the Node Timing Reference

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to enable timing 
switching. If you are already logged in, continue with Step 2.

Purpose This procedure describes how to off-load a diagnostic file. The diagnostic 
file contains a set of debug commands that were run on a node and their 
results. This file is useful to the Cisco Technical Assistance Center (TAC) 
when troubleshooting problems with the node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This procedure enables automatic timing reference switching or returns 
the node timing to normal operation.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 2 Complete the “DLP-G259 Manual or Force Switch the Node Timing Reference” task on page 13-19 as 
needed.

Step 3 Complete the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on 
page 13-20 as needed.

Stop. You have completed this procedure.

DLP-G259 Manual or Force Switch the Node Timing Reference

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Timing > Source tabs.

Step 2 From the Reference drop-down list for the desired Clock, choose the desired reference.

Step 3 From the Operation drop-down list for the desired Clock, choose one of the following options:

• Manual—This operation commands the node to switch to the reference you have selected if the 
synchronization status message (SSM) quality of the reference is not lower than the current timing 
reference.

• Force—This operation commands the node to switch to the reference you have selected, regardless 
of the SSM quality (if the reference is valid).

Note For information about the Clear option, see the “DLP-G260 Clear a Manual or Force Switch 
on a Node Timing Reference” task on page 13-20.

Step 4 Click Apply next to the timing source.

Step 5 Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid 
reference, the node switches to the selected timing reference. If the selected timing reference is invalid, 
a warning dialog box appears. Click OK; the node will not switch to the new timing reference. 

Step 6 Return to your originating procedure (NTP).

Purpose This task commands the node to switch to the timing reference you have 
selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Timing > Source tabs.

Step 2 Find the Clock reference that is currently set to Manual or Force in the Operation drop-down list.

Step 3 From the Operation drop-down list, choose Clear.

Step 4 Click Apply.

Step 5 Click Yes in the confirmation dialog box. If the normal timing reference is an acceptable valid reference, 
the node switches back to the normal timing reference as defined by the system configuration. If the 
normal timing reference is invalid or has failed, a warning dialog box appears. Click OK; the timing 
reference will not revert.

Step 6 Return to your originating procedure (NTP).

NTP-G113 View the ONS 15454 Timing Report

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to view the node 
timing status. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Maintenance > 
Timing > Report tabs.

Step 3 In the Timing Report area, you can view node timing information. The date and time of the report appear 
at the top of the report. The time stamp is the same as the alarms time stamp and can be configured using 
the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 9-12. Table 13-2 
describes the report fields and entries. 

Step 4 To update the report, click Refresh.

Purpose This task clears a Manual or Force switch on a node timing reference 
and reverts the timing reference to its provisioned reference.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This procedure displays the current status of the ONS 15454 timing 
references.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Table 13-2 ONS 15454 Timing Report

Item Description Option Option Description

Clock Indicates the 
timing clock. The 
report section that 
follows applies to 
the timing clock 
indicated.

NE The node timing clock.

BITS-1 Out The BITS-1 Out timing clock.

BITS-2 Out The BITS-2 Out timing clock.

Status Indicates the 
status of the 
timing clock.

INIT_STATE The timing reference has not been provisioned. For an NE 
reference, this status appears just before the first 
provisioning messages when the TCC2/TCC2P card is 
booting. Timing is provisioned to the internal clock of the 
node.

HOLDOVER_STATE The clock was locked onto a valid timing reference for 
more than 140 seconds when a failure occurred. Holdover 
state timing is a computation based on timing during the 
normal state combined with the node’s internal clock. The 
node holds onto this frequency until the valid reference is 
restored. This status appears for NE references only.

FREERUN_STATE The node is running off its internal clock without any 
modification except the calibrated value to bring timing to 
0 PPM. Freerun state can occur when a Force switch to the 
Internal clock is initiated, when all references fail without 
the 140 seconds of holdover data, or when only Internal 
timing references are defined. This status appears for NE 
references only.

NO_SYNC_STATE A synchronization timing reference is not defined. 
BITS-1 Out or BITS-2 Out default to this status until an 
OC-N/STM-N card is defined as its reference on the 
Provisioning > Timing tab. This status appears for 
external references only.

NE_SYNCH_STATE BITS-1 Out and BITS-2 Out use the same timing source as 
the NE. This is displayed when NE Reference is selected 
in the BITS-1 Out and BITS-2 Out Reference List on the 
Provisioning > Timing tab.

NORMAL_STATE The timing reference is locked onto one of its provisioned 
references. The reference cannot be Internal or 
NO SYNC STATE.

FAST_START_STATE The node has switched references, but the reference is too 
far away to reach NORMAL_STATE within an acceptable 
amount of time. FAST_START_STATE is a fast 
acquisition mode to allow the node to quickly acquire the 
reference. After it achieves this goal, the node progresses 
to NORMAL_STATE.

FAST_START_FAILED_STAT
E

A timing reference is too far away to reach in normal state. 
The FAST_START_STATE could not acquire sufficient 
timing information within the allowable amount of time.
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Status 
Changed 
At

Date and time of 
the last status 
change.

— —

Switch 
Type

Type of switch. AUTOMATIC The timing switch was system-generated.

Manual The timing switch was a user-initiated Manual switch.

Force The timing switch was user-initiated Force switch.

Reference Indicates the 
timing reference.

Three timing references are 
available on the Provisioning > 
Timing tab.

—

Selected Indicates whether 
the reference is 
selected.

Selected references are indicated 
with an X.

—

Facility Indicates the 
timing facility 
provisioned for 
the reference on 
the Provisioning > 
Timing tab.

BITS-1 The timing facility is a building integrated timing supply 
(BITS) clock attached to the node’s BITS-1 pins.

BITS-2 The timing facility is a BITS clock attached to the node’s 
BITS-2 pins.

OC-N/STM-N card with port 
number

If the node is set to line timing, this is the OC-N/STM-N 
card and port provisioned as the timing reference.

Internal clock The node is using its internal clock.

State Indicates the 
timing reference 
state.

IS The timing reference is in service.

OOS The timing reference is out of service.

Condition Indicates the 
timing reference 
state.

OKAY The reference is valid to use as a timing reference.

OOB Out of bounds; the reference is not valid and cannot be 
used as a timing reference, for example, a BITS clock is 
disconnected.

Condition 
Changed

Indicates the date 
and time of the 
last status change 
in MM/DD/YY 
HH:MM:SS 
format.

— —

SSM Indicates whether 
SSM is enabled 
for the timing 
reference.

Enabled SSM is enabled.

Disabled SSM is not enabled.

Table 13-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description
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Stop. You have completed this procedure.

NTP-G114 Inspect and Replace the Air Filter

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard. Statement 206

Note The air filters are single-use only. They must not be cleaned and reused. This is a Telcordia NEBS 
requirement, GR-63-CORE Issue 4. 

Note Air filters must be inspected every month. If they are dirty or clogged with dust, they must be replaced 
with a new air filter. 

Caution If you install the air filter below 15454E-CC-FTA or 15454-CC-FTA, only filters with part numbers 
700-23193-01 and 700-23194-01 can be used in this configuration.

SSM 
Quality

Indicates the SSM 
timing quality.

8 to 10 SSM quality messages 
might be displayed.

For a list of SSM message sets, see the “Timing” chapter 
in the Cisco ONS 15454 DWDM Reference Manual.

SSM 
Changed

Indicates the date 
and time of the 
last SSM status 
change in 
MM/DD/YY 
HH:MM:SS 
format.

— —

Table 13-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description

Purpose This procedure ensures that the air filter is free from dirt and dust, which 
allows optimum air flow and prevents dirt and dust from entering the 
shelf.

Tools/Equipment New air filter and pinned hex key tool

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Caution Although the air filter can work with older fan trays if it is installed with either side facing up, it is 
recommended that you install it with the metal bracing facing up to preserve the surface of the filter. You 
must install the air filter with the metal bracing facing up with 15454E-CC-FTA or 15454-CC-FTA.

Note To install the air filter inside the air ramp unit (15454E-AIR-RAMP  or 15454-AIR-RAMP), use the 
ETSI version of the air filter (15454-FTF2  or 15454E-FTF4).

Step 1 If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being 
careful not to dislodge any dust that might have collected on the filter and proceed to Step 8. Figure 13-4 
shows the reusable fan-tray air filter in an external filter bracket on an ANSI shelf. Figure 13-5 shows 
the reusable fan-tray air filter in an external filter bracket on an ETSI shelf. 

Step 2 If the filter is installed below the fan tray and not in the external filter brackets, open the front door of 
the shelf assembly. If the front door is already open, proceed to Step 3.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the 
key counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 3 (Optional) Remove the front door using the “DLP-G10 Remove the Front Door” task on page 1-23. If 
you do not want to remove the door or it is already removed, proceed to Step 4.

Figure 13-4 ANSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

FAN FAIL
CRIT
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Fan tray filter
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Figure 13-5 ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Step 4 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 5 Pull the handles and slide the fan-tray assembly one half inch (12.7 mm) out of the shelf assembly and 
wait until the fans stop. 

Step 6 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 7 Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that might have 
collected on the filter.

Step 8 Visually inspect the air filter material for dirt and dust.

Step 9 Replace the air filter with a new one if the air filter is dirty or clogged with dust.

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can 
damage the ONS 15454 cards.

Step 10 Replace the air filter:

a. If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back 
of the brackets.

b. If the filter is installed below the fan-tray assembly, slide the dry/clean air filter into the recessed 
compartment at the bottom of the shelf assembly. Put the front edge of the air filter flush against the 
front edge of the recessed compartment. Push the fan tray back into the shelf assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and 
readjust the position of the reusable filter until the fan tray fits correctly.

61
23

5

Fan tray filter
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Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly 
inserted. 

Step 11 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information.

Step 12 Rotate the retractable handles back into their compartments.

Step 13 If you removed the door, complete the “NTP-G40 Replace the Front Door” procedure on page 13-29. If 
not, close and lock the door.

Stop. You have completed this procedure.

NTP-G115 Clean Fiber Connectors

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Step 1 Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2 Replace any damaged fiber connectors.

Note Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3 Complete the “DLP-G262 Clean Fiber Connectors with CLETOP” task on page 13-27 as necessary.

Step 4 Complete the “DLP-G263 Clean the Fiber Adapters” task on page 13-28 as necessary. 

Purpose This procedure cleans the fiber connectors.

Tools/Equipment Inspection microscope

Compressed air/duster

Type A Fiber Optic Connector Cleaner (CLETOP reel)

Isopropyl alcohol 70 percent or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note To clean multi-fiber optic connectors, complete the “DLP-G261 Clean Multi Fiber-Optic Cable 
Connectors” task on page 13-27 as necessary.

Stop. You have completed this procedure.

DLP-G261 Clean Multi Fiber-Optic Cable Connectors

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Statement 1051

Step 1 Remove the protective cap on the optical fiber cable connector.

Step 2 Read the manufacturer (cleaning cartridge) instructions to insert the connector into the cleaning 
cartridge.

Step 3 Slide the lever on the cartridge to swipe the connector surface.

Step 4 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector. 

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean.

Step 5 Return to your originating procedure (NTP).

DLP-G262 Clean Fiber Connectors with CLETOP

Purpose This task cleans the multi fiber optic connectors

Tools/Equipment Cleaning Cartridge for multi fiber optic connectors

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task cleans the fiber connectors with CLETOP.

Tools/Equipment Type A Fiber Optic Connector Cleaner (CLETOP reel)

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required
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Step 1 Remove the dust cap from the fiber connector.

Step 2 Press the lever up to open the shutter door. Each time you press the lever, you expose a clean wiping 
surface.

Step 3 Insert the connector into the CLETOP cleaning cassette slot, rotate one quarter turn, and gently swipe 
downwards.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap 
using a CLETOP stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

DLP-G263 Clean the Fiber Adapters

Step 1 Remove the dust plug from the fiber adapter.

Step 2 Insert a CLETOP stick swab (14100400) into the adapter opening and rotate the swab.

Step 3 Place dust plugs on the fiber adapters when not in use.

Step 4 Return to your originating procedure (NTP).

Onsite/Remote Onsite

Security Level None

Purpose This task cleans the fiber adapters.

Tools/Equipment CLETOP stick swab

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-G40 Replace the Front Door 

Note Be careful not to crimp any fiber cables that are connected to the MXP/TXP cards or DWDM cards. 
Some might not have the fiber boot attached. 

Step 1 Insert the front door into the hinges on the shelf assembly.

Step 2 (ANSI only) Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside 
of the door. Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench (Figure 13-6).

Figure 13-6 Installing the Door Ground Strap Retrofit Kit

Step 3 (ANSI only) Attach the other end of the ground strap to the longer screw on the fiber guide.

a. Attach the lock washer.

Purpose This procedure replaces the front door and door ground strap after 
installing cards and fiber-optic cables. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-21

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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b. Attach the terminal lug.

c. Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug. 

Note To avoid interference with the traffic (line) card, make sure the ground strap is in a flat 
position when the door is open. To move the ground strap into a flat position, rotate the 
terminal lug counterclockwise before tightening the Kepnut.

Step 4 Replace the left cable-routing channel if it was removed. If not, continue with Step 5.

Step 5 Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.

Figure 13-7 shows the shelf assembly with the front door and ground strap installed.

Figure 13-7 Shelf Assembly with Door Ground Strap Retrofit Kit Installed (ANSI)

Step 6 Swing the door closed and lock the door with the provided pinned-hex key. Turn the key clockwise to 
lock the door; counterclockwise to unlock it.

Stop. You have completed this procedure. 

71
04

6
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NTP-G116 Replace the Fan-Tray Assembly

Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies 
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). The fan-tray assembly includes a 
pin that prevents it from being installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can 
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the backplane.

Caution 15454-CC-FTA (ANSI) is compatible with Software R2.2.2 and greater, and shelf assemblies 
15454-SA-ANSI and 15454-SA-HD. 15454E-CC-FTA (ETSI) is compatible with Software R4.0 and 
greater, and shelf assembly 15454-SA-ETSI.

Caution As with the FTA3, the 15454E-CC-FTA and 15454-CC-FTA Fan Fail LED on the front of the fan-tray 
assembly illuminates when one or more fans fail to indicate that a fan-tray assembly or AIP replacement 
is required. But the Fan Fail LED on the 15454E-CC-FTA and 15454-CC-FTA will also illuminate when 
only one power source is connected to the chassis, and or any fuse blows. In such conditions, the Fan 
Alarm is triggered and the fans run at maximum speed.

Note To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities. 

Step 1 Review Table 13-3 (ANSI) or Table 13-4 (ETSI) to ensure that you have compatible components when 
replacing the fan-tray assembly. Note the alarms that will be generated when an incompatibility occurs.

Note If you need to determine the hardware that has been installed on a node, click the Inventory tab 
in node view.

Purpose This procedure replaces a malfunctioning fan-tray assembly.

Tools/Equipment None

Prerequisite Procedures NTP-G8 Install the Fan-Tray Assembly

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Table 13-3 Incompatibility Alarms for ONS 15454 ANSI

Shelf Assembly1

1. 15454-SA-NEBS3E (P/N: 800-07149-xx) or 15454-SA-NEBS3 (P/N: 800-06741-xx) = shelf assemblies released before 
ONS 15454 Release 3.1
15454-SA-ANSI (P/N: 800-19857-01) = ONS 15454 Release 3.1 and later shelf assembly
15454-SA-HD (P/N: 800-24848) = ONS 15454 Release 3.1 and later shelf assembly

Fan Tray2

2. 5A Fan Tray = 15454-FTA3 (P/N: 800-19858-xx), 15454-FTA3-T (P/N: 800-21448-xx), 15454-CC-FTA 
(P/N: 800-27558-xx)
2A Fan Tray = 15454-FTA2 (P/Ns: 800-07145-xx, 800-07385-xx, 800-19591-xx, 800-19590-xx)

AIP3

3. 5A AIP (P/N: 73-7665-01), 2A AIP (P/N: 73-5262-01)

10G Cards4

4. 10G cards include the XC10G, OC192, and OC48AS.

Ethernet Cards5

5. 2.5G compatible indicates cards that are compatible with the XCVT cross-connect card. 10G compatible indicates cards that 
are compatible with the XC10G and XC-VXC-10G cross-connect cards.

Alarms

— — No fuse — — Mismatch of 
equipment attributes 
(MEA) on the alarm 
interface panel (AIP)

NEBS3E or NEBS3 2A 2A No — None

NEBS3E or NEBS3 2A 2A Yes — MEA on 10G

NEBS3E or NEBS3 2A 5A No — None

NEBS3E or NEBS3 2A 5A Yes — MEA on 10G

ANSI or HD 2A 2A No — None

ANSI or HD 2A 2A Yes 2.5G compatible MEA on fan tray, 
AIP, and Ethernet

ANSI or HD 2A 2A Yes 10G compatible MEA on fan tray and 
AIP

ANSI or HD 2A 5A No Either None

ANSI or HD 2A 5A Yes 2.5G compatible MEA on fan tray and 
Ethernet

ANSI or HD 2A 5A Yes 10G compatible MEA on fan tray

ANSI or HD 5A 2A No Either MEA on AIP

ANSI or HD 5A 2A Yes 2.5G compatible MEA on AIP and 
Ethernet

ANSI or HD 5A 2A Yes 10G compatible MEA on AIP

ANSI or HD 5A 5A No Either None

ANSI or HD 5A 5A Yes Either None

Table 13-4 Incompatibility Alarms for ONS 15454 ETSI 

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards Alarms

15454E-SA-ETSI 2A No — None

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 2A No — None
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Step 2 Open the front door of the shelf assembly. If the shelf assembly does not have a front door, continue with 
Step 4. 

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 3 (Optional) Complete the “DLP-G10 Remove the Front Door” procedure on page 1-23 to remove the 
front door. If you do not want to remove the door, proceed to Step 4.

Step 4 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 5 Fold out the retractable handles at the outside edges of the fan tray.

Step 6 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly. 
Figure 13-8 shows the location of the fan tray on the ONS 15454 ANSI shelf.

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 5A No — MEA on fan tray

15454E-SA-ETSI 5A Yes — MEA on fan tray and 10G 
cards

15454E-SA-ETSI 5A No — None

15454E-SA-ETSI 5A Yes — MEA on 10G

ETSI 2A No — None

ETSI 2A Yes 2.5G compatible MEA on fan tray or 
Ethernet

ETSI 2A Yes 10G compatible MEA on fan tray

ETSI 2A No Either None

ETSI 2A Yes 2.5G compatible MEA on fan tray, Ethernet

ETSI 2A Yes 10G compatible MEA on fan tray

ETSI 5A Yes 2.5G compatible MEA on Ethernet

ETSI 5A No Either None

ETSI 5A Yes Either None

1. 15454-SA-ETSI (P/N: 800-08708-XX) = ONS 15454 SDH Release 3.3 and later shelf assembly

2. 5A Fan Tray = 15454E-FTA-60V, 15454E-CC-FTA
2A Fan Tray = 15454E-FTA-48V 

3. 10G cards = XC10G, XC-VXL-10G, XC-VXC-10G

Table 13-4 Incompatibility Alarms for ONS 15454 ETSI  (continued)

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards Alarms
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Figure 13-8 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)
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Figure 13-9 shows the location of the fan tray on the ONS 15454 ETSI shelf. 

Figure 13-9 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ETSI)

Step 8 If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the 
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket (ANSI shelf 
only), you can slide the existing air filter out of the bracket and replace it at anytime. For more 
information on the fan-tray air filter, see the “NTP-G114 Inspect and Replace the Air Filter” procedure 
on page 13-23.

Step 9 Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into 
the corresponding receptacle on the backplane.

Step 10 To verify that the tray has plugged into the backplane, ensure that the LCD on the front of the fan tray 
is activated.

If you removed the door, complete the “NTP-G40 Replace the Front Door” procedure on page 13-29.

Stop. You have completed this procedure.

Note The estimated replacement time by a skilled technician is 2 minutes.
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NTP-G117 Replace the ANSI Shelf Alarm Interface Panel

Caution Do not use a 2A AIP with a 5A fan-tray assembly; doing so will cause a blown fuse on the AIP.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Caution Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and 
result in a loss of data. For assistance with AIP replacement, contact the Cisco TAC. See the “Obtaining 
Documentation and Submitting a Service Request” section on page lxx.

Step 1 Review Table 13-3 on page 13-32 to ensure that you have compatible components when replacing the 
ANSI shelf AIP and note the alarms that will occur when an incompatibility occurs.

Step 2 Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits:

a. In network view or multishelf view (multishelf mode), click, click the Maintenance > Software 
tabs. The working software version for each node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade 
document. No hardware should be changed or circuit repair performed until after the software 
upgrade is complete. If you do not need to upgrade software or have completed the software 
upgrade, proceed to Step 3.

Step 3 Record the MAC address of the old AIP:

a. Log into the node where you will replace the AIP. See the “DLP-G46 Log into CTC” task on 
page 2-26.

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the 
Provisioning > Network tabs.

c. Record the MAC address shown in the General tab (Figure 13-10).

Purpose This procedure replaces the AIP on the ONS 15454 ANSI shelf 
assembly.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 13-10 Find the MAC Address

Step 4 Call Cisco TAC for assistance in replacing the AIP and maintaining the original MAC address. See the 
“Obtaining Documentation and Submitting a Service Request” section on page lxx.

Step 5 Complete the “DLP-G13 Remove the Lower Backplane Cover” task on page 1-28.

Step 6 Unscrew the two screws that hold the AIP cover in place.

Step 7 Grip the cover and gently pull away from the backplane.

Note On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI 
shelf (P/N: 800-19857), the AIP cover is metal.

Step 8 Grip the AIP and gently pull it away from the backplane.

Step 9 Disconnect the fan-tray assembly power cable from the AIP.

Step 10 Set the old AIP aside for return to Cisco.

Caution The type of shelf that the AIP resides in determines the version of AIP that should replace the failed AIP. 
The 15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A 
AIP, (P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 
(P/N: 800-07149) shelves and earlier use the 2A AIP (P/N: 73-5262-01). 

Caution Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD 
(P/N: 800-24848) shelf; doing so will cause a blown fuse on the AIP.

Step 11 Attach the fan-tray assembly power cable to the new AIP.
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Step 12 Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 13 Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 14 Replace the lower backplane cover and secure the cover with the five screws.

Step 15 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network tabs.

Caution Cisco recommends that TCC2/TCC2P card resets be performed in a maintenance window to avoid any 
potential service disruptions.

Step 16 Reset the standby TCC2/TCC2P card:

a. Right-click the standby TCC2/TCC2P card and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears 
on the card in CTC.

Note The reset takes approximately five minutes. Do not perform any other steps until the reset is 
complete.

Step 17 Complete the “DLP-G250 Reset the TCC2/TCC2P Card” task on page 13-13 to reset the active 
TCC2/TCC2P card.

Step 18 From the File drop-down list, choose Exit to exit the CTC session.

Step 19 Log back into the node. In the Login dialog box, choose (None) from the Additional Nodes drop-down 
list. 

Step 20 Record the new MAC address:

a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network tabs.

b. Record the MAC address shown in the General tab.

Step 21 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab. Note that 
all circuits listed have a status of PARTIAL.

Step 22 In node view (single-shelf mode) or multishelf view (multishelf mode), choose Repair Circuits from 
the Tools drop-down list. The Circuit Repair dialog box appears.

Step 23 Read the instructions in the Circuit Repair dialog box (Figure 13-11). If all the steps in the dialog box 
have been completed, click Next. Ensure that you have the old and new MAC addresses.
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Figure 13-11 Repairing Circuits

Step 24 The Node MAC Addresses dialog box appears (Figure 13-12):

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 3.

c. Click Next.

Figure 13-12 Recording the Old MAC Address Before Replacing the AIP

Step 25 The Repair Circuits dialog box appears (Figure 13-13). Read the information in the dialog box and click 
Finish.
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Figure 13-13 Circuit Repair Information

Note The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes 
or more depending on the number of circuits provisioned.

When the circuit repair is complete, the Circuits Repaired dialog box appears.

Step 26 Click OK.

Step 27 In node view of the new node, click the Circuits tab. Check to ensure that all circuits listed have a status 
of DISCOVERED. If all circuits listed are not DISCOVERED, call the Cisco TAC at (800) 553-2447 to 
open a Return Material Authorization (RMA).

Stop. You have completed this procedure.

NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane 
Cover

Step 1 Use the Phillips screwdriver to unscrew the five retaining screws that hold the metal cover in place. 

Step 2 Grasp the metal cover on each side.

Step 3 Gently pull the metal cover away from the backplane.

Step 4 Place the plastic cover against the shelf assembly and align the screw holes on the cover and the shelf 
assembly (Figure 13-14).

Purpose This procedure replaces the metal cover with the plastic cover located at 
the bottom rear of the ONS 15454 ANSI shelf.

Tools/Equipment Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
13-40
Cisco ONS 15454 DWDM Procedure Guide, R8.5

78-18108-02



 

Chapter 13      Maintain the Node
DLP-  G263 Clean the Fiber Adapters
Figure 13-14 Attaching Plastic Lower Backplane Cover

Step 5 Tighten the five retaining screws that hold the plastic cover in place.

Stop. You have completed this procedure.

7
8
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0
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NTP-G135 Edit Network Element Defaults

Note For a list of NE defaults, see the “Network Element Defaults” appendix in the Cisco ONS 15454 DWDM 
Reference Manual.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to edit NE 
defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults tabs. Wait for the Defaults selector frame to load the defaults. This could take several minutes.

Step 3 Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing 
node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all 
available NE defaults (both node- and card-level) under Default Name. 

Step 4 Locate a default that you want to change under Default Name. 

Step 5 Click in the Default Value column for the default property that you are changing and either choose a 
value from the drop-down list (when available), or type in the desired new value.

Note If you click Reset before you click Apply, all values will return to their original settings. 

Step 6 Click Apply (click in the Default Name column to activate the Apply button if it is unavailable). You 
can modify multiple default values before applying the changes. 

A pencil icon will appear next to any default value that will be changed as a result of editing the defaults 
file. 

Step 7 If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully 
applied to the node. Click Yes.

If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see 
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder 
cards see Chapter 5, “Provision Transponder and Muxponder Cards.”

Purpose This procedure edits the factory-configured NE defaults using the NE 
Defaults editor. The new defaults can be applied to the node where they are 
edited, or exported to a file to be imported for use on other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G136 Import Network Element Defaults

Note For a list of NE defaults, refer to the “Network Element Defaults” document.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to import NE 
defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults tabs. 

Step 3 Click Import.

Step 4 If the correct file name and location of the desired file do not appear in the Import Defaults from File 
dialog box, click Browse and browse to the file that you are importing.

Step 5 When the correct file name and location appear in the dialog box, click OK. If you are importing the 
factory defaults, the correct file name is 15454-defaults.txt for ANSI shelves and 15454SDH-defaults.txt 
for ETSI shelves. 

A pencil icon will appear next to any default value that will be changed as a result of importing the new 
defaults file. 

Step 6 Click Apply.

Step 7 If the imported file fails to pass all edits, the problem field shows the first encountered problem default 
value that must be fixed. Change the problem default value and click Apply. Repeat until the imported 
file passes all edits successfully.

Step 8 If you are modifying node-level defaults, a dialog box appears telling you that defaults were successfully 
applied to the node. Click Yes.

Step 9 If you are modifying the IIOP Listener Port setting, a dialog box appears warning you that the node will 
reboot and asks if you want to continue. Click Yes.

Purpose This procedure imports the NE defaults using the NE Defaults editor. The 
defaults can either be imported from the CTC software CD (factory 
defaults) or from a customized file exported and saved from a node.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Note Changes to most node defaults reprovision the node when you click Apply. Changes made to 
card settings using the Defaults Editor do not change the settings for cards that are already 
installed or slots that are preprovisioned for cards, but rather, change only cards that are installed 
or preprovisioned thereafter. To change settings for installed cards or preprovisioned slots, see 
Chapter 11, “Change DWDM Card Settings.” To change settings for transponder or muxponder 
cards, see Chapter 5, “Provision Transponder and Muxponder Cards.”

Note Changing some NE defaults can cause CTC disconnection or a reboot of the node in order for 
the default to take effect. Before you change a default, view the Side Effects column of the 
Defaults editor (right-click a column header and select Show Column > Side Effects) and be 
prepared for the occurrence of any side effects listed for that default.

Stop. You have completed this procedure.

NTP-G137 Export Network Element Defaults

Note The defaults currently displayed are exported whether or not they have been applied to the current node.

Note The NE defaults can also be exported from the File > Export menu. These exported defaults are for 
reference only and cannot be imported.

Note For a list of NE defaults, refer to the “Network Element Defaults” document.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to export NE 
defaults. 

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Defaults editor tabs. 

Step 3 Click Export.

Step 4 If the location where you want to export the file does not appear in the Export Defaults to File dialog 
box, click Browse and browse to the location. 

Purpose This procedure exports the NE defaults using the NE Defaults editor. The 
exported defaults can be imported to other nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only 
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Step 5 Change the file name to something that is easy to remember (the file name has no extension). 

Step 6 Click OK.

Stop. You have completed this procedure.

NTP-G166 View the Facilities

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to view DWDM 
facilities.

Step 2 In node view (single-shelf mode), shelf view (multishelf mode), or multishelf view (multishelf mode), 
click the Maintenance > DWDM> All Facilities tabs. 

• Marked—Displays a check mark if you have designated the facility for logical grouping. To mark a 
facility to group it with others, go to Step 3.

• Location—Displays the slot number, slot type, port number, and port type of the facility.

• Admin State—Displays the administrative state of the facility.

• Service State—Displays the service state of the facility.

• Power—Displays the power level of the facility.

Step 3 To mark certain facilities to group during column sorting, click the desired row and click Mark. A check 
mark appears in the Marked column. Click the Marked column header to group all of the checked 
facilities in ascending order. Click the Marked header again to sort in descending order.

Step 4 To sort the facilities by the Location, Admin State, Service State, or Power columns in ascending order, 
click on the desired column header. Click the column header again to sort in descending order.

Stop. You have completed this procedure.

Purpose This procedure displays DWDM facility information for all facilities in a 
node (single-shelf mode), shelf view (multishelf mode), or multishelf node 
(multishelf mode).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance and higher
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